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Editor's Note 
Welcome to the Summer 2003 issue, the third of four quarterly issues for 2003. 

We'd like to welcome a new contributor, JP Kabala. Check out her Paranormal PSP8 tutorials at 
www.jpkabala.com/paranormal/. In this issue, JP shows you how to make a pleasingly gaudy, old-fashioned 
postcard. 

Mike takes a new look at text on a path, this time using PSP 8. And Filter Munky is quite wild about a new 
plugin from AV Bros. 

We're also happy to see some new online resources for Paint Shop Pro: Jasc's new user forums and a resource 
site called PSP-X.com. 

Thanks for reading - we'll see you back again in the fall! 

 

andy@shafran.com 
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Headlines & News 
Collected by Andy Shafran and Sally Beacham 

Jasc Forums Open! 

Close on the tails of the release of Paint Shop Pro 8, Jasc Software opened up their online forums for Paint 
Shop Pro 8 and Paint Shop Photo Album. Head over to the forums at http://forums.jasc.com/. Share 
information and resources, ask questions, and help other users, too. 

A New PSP Resource Site 

Have you heard the buzz about a new Paint Shop Pro resource site - http://www.psp-x.com/? See what tools 
for "mass construction" the mysterious Agent-X has available for download. 

FilterMunky's Plug-In News 

Fabric Weaver 

Geomantics recently introduced a new Photoshop-compatible plugin called Fabric Weaver that can generate 
thousands of different woven fabrics, in particular, realistic tartan plaids! $49 for a single user license. 
http://www.geomantics.com/ 

Plaid Lite 

Speaking of plaids, namesuppressed design recently introduced Plaid Lite, for $14.95. Not quite as flexible as 
Fabric Weaver, but a lot more reasonable in cost, and simple to operate. Plus, FilterMunky loves the 
namesuppressed guy, he's "peachy." 
http://www.namesuppressed.com/design/plugins-plaidlite.shtml 

FocalBlade 

Harald Heim at www.thepluginsite.com has been working overtime producing his new line of photo correction 
and enhancement plugins - Photo Wiz. The latest entry is FocalBlade, a sharpening plugin with user options 
for Novice and Expert modes, and a number of split-view preview options that make sharpening your photos a 
breeze. 
http://www.thepluginsite.com/products/photowiz/focalblade/index.htm $49.95 for the ESD or $59.95 CD 
version, shipping world-wide included. You can also order it in a bundle with ColorWasher for $89.95 ESD or 
$99.95 CD, delivered. 
http://www.thepluginsite.com 

Lattice Filters 

Redfield Plugins just released new versions of their Lattice Composer and Lattice XP filters, and a new 
freeware Water Ripples filter. 
http://www.redfieldplugins.com/ 

Postcards from the Edge 
By JP Kabala 
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Maybe you've just come back from vacation and you are looking for an interesting way to display your 
pictures on your website. Maybe you're involved with a community project and you want a fun way to 
highlight the most unique features of your area. Maybe you're planning a reunion or a party and just like the 
retro feel of the vintage postcard look for your invitation-- whatever the inspiration, this tutorial will teach you 
how to reproduce the look of "large letter" postcards of the 40s and 50s. 
  

Here are some images of real vintage large letter cards: 

Historical Museum of South Florida 

The Postcard 

The Large Letter Page 

US Postal Service Stamps Page 

Even if you're not familiar with the term, you've undoubtedly seen "large letter" cards (they still make them, 
though they are not as typical as they were half a century ago) where the name of the locale is spelled out in 
a bold font, and often each letter of the font is filled with an image-- originally illustrated, later photographic-- 
of a key point of interest. If you find any real ones in Mom or Grandma's attic, they've become highly 
collectible. They were originally printed by one of five or six companies. And in July of 2002, the US Postal 
Service released a series of commemorative stamps celebrating this unique nostalgic art form. (It should be 
noted that the USPS stamps did not use photos to fill the letters due to their small size, but given that they 
created one for each State of the Union, it is an excellent source for inspiration. 
  

What You'll Need 

To complete this project you'll need: 

? A heavy, bold font, most frequently without serifs. Dozens of these are available for free download on 
the web. Fonts you might consider are Broad, Club, Impact, Fatso, Broadway, Lithograph, Futura Extra 
Bold or similar. This will be used to create your "large letters." FontFreak.com is one good source of 
free or inexpensive novelty fonts. There are many others. We're going to use Impact here because you 
probably already have it installed, but in your own work, experiment with others.  

? A script font like Cataneo, Monotype Corsiva, Park Avenue, WhisperWrite, Heather, Holiday-India, or 
similar. This will be used to create your "Greetings from" text. We're going to use Park Avenue 
here because you probably already have it installed, but in your own work, experiment with others.  

? Several small photographs of key points of interest. A zipped file with some of mine can be found on my 
Resources page. You will likely have your own.  
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? Two or three pieces of cheesy clipart typical of your area. Look at the large letter postcard samples for 
ideas. Palm trees and flamingos are great for Florida, but when you look at the examples, you'll see 
cactus in the southwest, dice and roulette wheels used for Las Vegas and Reno, ears of corn in Iowa, 
bass in the lakes regions, etc. The more stereotypical the better. Be more cautious looking for this stuff 
for free on the web, you can end up in a Pop-up and spyware nightmare. If you don't have at least one 
crummy clipart disc in your collection, (they can be had for under $10 just about anywhere) if you're a 
user of Microsoft Word you have access to their Clips Online. The ones I used are also on my Resources 
page. 
   

It should be noted going in that "subtle" and "understated" are not part of the plan here. "Outrageous" 
"oversized" and "over the top" are more like it. Really look at the vintage samples. (links provided) These 
postcards were "baby billboards" and about as subtle as a sledgehammer. 
   

Creating the Card 

OK, now we're ready to design a "masterpiece" of travel kitsch! 

I'll walk you through how I created my postcard. You can then adapt this method to make a card for your own 
locale. 

1. Open a new image. The actual pixel size will depend on your planned usage (print or Web) but the 
proportion always remains the same: 4 high x 6 wide. For this exercise we'll open an image 800 high by 
1200 wide with, for the time being, a white raster background. 

2. Colors are more primary than subtle in this sort of postcard, so flood fill your background with a bright 
solid color or gradient. I chose the Landscape Morning gradient that ships with Paint Shop Pro 8. 

3. Create a new layer. On that layer, with a simple 5 pixel round brush, I drew some random lines in black 
and white over the green areas. Perfection isn't necessary, or even desirable. (Image cropped and size 
reduced in these illustrations by 50%) It looks like this. 

 

4. Choose Effects > Distortion > Wave. When the dialog box opens, set these parameters: 

Horizontal Displacement: Amplitude 4, Wavelength 10 
Vertical Displacement: Amplitude 2, Wavelength 30 
Edge Mode Transparent 

Then click OK. You'll end up with this: 

 

5. But the real "magic" comes into play when you 
a) change the layer blend mode to Dissolve 50% in the layers palette, and 
b) Choose Adjust > Blur > Motion Blur and set the Angle at 90% and the Strength at 100%. Then 
you end up with this: 
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If we were doing a project a little more subtle than large letter postcards, I might recommend 
something else, but for our purposes here, this is fine. It doesn't look a lot like real waves, but so little 
of this will be visible in the finished piece that more detail isn't needed. Right -click on the layer in the 
Layers palette and choose Merge Down from the context-sensitive menu that appears. 

6. Choose the Pen tool. (What you'll draw in this step is going to be invisible later, so line color and fill is 
not important.) Beginning in the lower left hand corner and extending to a point just above the horizon 
on the right side, draw a vector line segment. There are many ways to do this. I prefer to use the Pen 
tool options as shown here: 

 

After your line is formed, right-click on the End node and choose Curve Before from the context-
sensitive menu which appears. An adjustment handle will appear. Drag the handle upward to create a 
curved line. Now select the Start node and right-click on it. Choose Curve After and drag downward on 
the handle to change your line to a smooth S-curve as shown. (I have greatly exaggerated the 
thickness of the line so you can see it better. A single pixel is fine, since it is going to serve as a guide 
only.) Do not deselect your line before moving on to the next step. 

 

7. Choose the Text tool.  Hover the mouse over the curved line until you see the text icon change to a 
capital A over a curved line. This is the symbol for "text curved to a path". Click on the line and the 
Text Entry dialog box appears. Type in your text and highlight it. I placed a bright orange color in the 
Material palette's Foreground swatch and yellow in the Background swatch, then I set the tool options 
as shown. Do not deselect your vector text. There are a couple of new/changed options here worth 
discussing before moving on.  
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The first is Font Size. I once used a font size of 150 in a tutorial and got dozens of complaints because 
"the menu doesn't go higher than 72!" That's true. If you want a number higher than 72, you have to 
type it in. 

The second option is Warp Text. This is new to Paint Shop Pro 8. What this does is stretch the tops and 
bottoms of the text string's characters in order to make the text conform to the curve more smoothly. 
Try your text both ways, both warped and unwarped. I opted to keep mine warped because I liked the 
look of it. You may find you don't like the way it looks with your font or text. 

The third issue, not really shown here, is Alignment. I chose center alignment, but found that I had to 
add a couple of spaces after the word "Clearwater" to get it to line up on my curve properly. Go ahead 
and add spaces before or after your text if you need to do so to get the look you want. No one will ever 
know. 

And last but not least is the subject of kerning and leading scales. In Paint Shop Pro 8, the scale of 
these has been changed radically. I could not get a definitive answer from Jasc, but it appears that 1 
unit of kerning or leading is approximately 1/4 of a pixel or less. This means that the tool is more 
flexible and accurate than before, but it also means that any kerning or leading setting used in tutorials 
from earlier versions will not produce the same results in Paint Shop Pro 8. (Just an FYI.) 

Moving on.... 

8. In the tools palette, expand the plus sign to the left of the Vector 1 layer to show the objects on the 
layer. Click the Eye icon next to the object labeled "New Shape" to place a red X through the eye and 
hide the line. Then make sure your text object is highlighted and choose Selections > From Vector 
Object. A marquee then appears around each letter. Do not Deselect. Choose Selections > 
Load/Save Selection > Save to Alpha Channel. Accept the defaults and click Save. Do not 
Deselect. 

9. Hide the vector text layer and create a new raster layer. Make the Effects toolbar visible by choosing 
View > Toolbars > Effects. With the selection still active, click the Drop Shadow icon on the effects 
toolbar. When the dialog box opens, reset the settings to the default by clicking the curved arrow icon 
in the upper right corner, then change the Color of the shadow to orange and the Opacity to 100%. 
Click OK.  

10. Deselect, then click the Drop Shadow icon on the Effects toolbar again. Change the Horizontal and 
Vertical offset settings to 1, and change the Color to a darker shade of orange. Click OK. Now hold 
down the Shift key and click the Drop Shadow icon 10 more times. Release the Shift key and click the 
icon again. Change the Color to black and the Blur to 0. Click OK. Then hold down the Shift key and 
click the Drop Shadow icon four more times. This creates a soft-looking extrusion as shown below. (If 
you prefer a crisper looking extrusion, set the blur to 0 throughout steps 9 and 10.) 
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11. Make your text layer visible again and drag it to the top of the stack in the Layers palette. Choose the 
Text tool again and set your Background color to black and your Foreground to null. Click in the upper 
left corner and using a Park Avenue 72 point bold font (or other script font you prefer) set the words 
"Greetings from" on the page. Do the same with the word "Florida" just below the curve of the text. 

 

12. This is starting to look like a postcard, but it's far too tasteful at this point. Open the flamingo clipart 
found on my Resources page and copy and paste it as a new layer. Drag the layer down so it is just 
above the Background layer. Do the same with the palm tree and hibiscus files, using the Deform tool 
to resize and position them. You may find that you need to move the words "Greetings from" and 
"Florida" around a bit. To do so, just click on them in the Layers palette and choose the Object 
Selection tool (the last one on the Tools palette) to shift the text objects without disturbing anything 
else. 

13. We've almost reached maximum tackiness now, but we still have to get your vacation snaps integrated 
into your masterpiece.  
There are lots of different ways to do this. This one moves quickly and may be an approach you haven't 
tried before: 

a. Open the first snapshot that you want to include.  
b. Select the portion of the image  you want to place inside the lettering and copy and paste it as a 

new layer.  (You can close the original snapshot as soon as you copy it to the clipboard.)  
c. Reduce the opacity of this new layer to about 75%.    
d. Use the Deform tool to resize and position it roughly over the text as you wish.  
e. From the Selections menu, choose Load Selection from Alpha Channel. When the dialog box 

opens, place a check in the box that says Invert image and click Load.  
f. When the marquee appears, press the Delete key to cut away the excess, then Select None 

(Ctrl+D). If any of your letters accidentally overlap the others, it is easy to use the Eraser for 
touchups now BEFORE you merge the layer down.  

g. Open the next snapshot. Repeat steps a, b, d, e, and f above, but do NOT reduce the opacity of 
the new layer. When you've completed step f, right -click on the layer in the Layers palette and 
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choose Merge Down. (The Opacity will automatically drop to 75%.)  
h. Repeat step g for each snapshot. When all the letters are filled in, reset the opacity of the layer 

to 100%. 
   

14. When all the letters are filled with images and they are all on the same layer, drag that layer below 
your vector text layer. Double-click on the vector text object that contains your large letters. 
("Clearwater" in this example.) When the text editing options open, change the text fill color from 
yellow to null to let the pictures show through behind the orange frame. After all was said and done, I 
also opted at this point to change the color of the text for the word "Florida" to yellow and make it a bit 
larger. 

And there you have it! Funky retro style with your own snapshots! (If you have any luck, you'll go someplace 
interesting on vacation. If you have brains, you'll choose a place with a name shorter than Clearwater for your 
first attempt at this technique. Wish I'd had great pictures of Taos or Nome!) 

  

Despite her total lack of blue hair and white polyester pants, JP Kabala lives and and works on the shores of 
Tampa Bay in Florida. As the Managing Director of Kabala Portfolio Design (an instructional and multimedia 
design firm), JP helps companies and professionals find the best way to communicate, educate, and support 
their clients and employees. A private beta tester for PSP 8, she also has an offbeat but informative series of 
tutorials for PSP 8 at http://wwww.jpkabala.com/. 

Text On A Path in Paint Shop Pro 
by Mike Thomas 

The process for producing text on a path hasn't changed much between Paint Shop Pro 7 and Paint Shop Pro 
8. The only real differences are in how you select the various options. This tutorial will walk you through one 
method using Paint Shop Pro 8 of creating text on circular paths, like what is shown in Figure 1. 

 

 

Creating the Paths 

Begin by defining the paths:  

1. Open a new raster image 300 by 300 pixels with a white background. 

Figure 1: Text on Circular Paths
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2. OPTIONAL: Use Rulers to help in positioning your circles. Alternatively, you can look at the Status bar 
to find your placement points, but I like using the Rulers since that keeps my focus on the image I'm 
creating. To toggle Rulers on, choose View > Rulers. 

3. As shown in Figure 2, set the Background material box to transparent. The shape you then draw will be 
an outline with no material inside. 

4. Click the Preset Shapes tool, shown in Figure 3, and in the Tool Options palette check the Create as 
Vector option. 

 
 

5. Place the cursor on (250,50) and drag to (50,250). This gives you a counterclockwise circular path. 

6. Choose, Layers > New Vector Layer. 

7. Place the cursor on (70,70) and drag to (230,230). This gives you a clockwise circular path. Your image 
should now look like Figure 4. Notice the smaller circle is selected (and so is surrounded by the Object 
bounding box).  

Figure 2: Setting the Background Material to Transparent

Figure 3: The Preset Shapes tool

NOTE: The direction in which you drag a vector shape determines the direction of the vector 
path.
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The Uppermost Text 

1. Deselect the inner circle by pressing Ctrl+D (or choosing Selections > Select None ). 

2. Choose the Text tool, shown in Figure 5. You can use any text settings you want. For the purposes of 
this tutorial, I chose a Verdana font filled with the Pastel Flowers pattern, center aligned, with the text 
created as a vector object. Although choosing Create as Vector for your text is not necessary, it 
allows you to edit the text even in a later editing session (as long as you save the image in 
the .pspimage format). 

 
 

3. Place the cursor at the top of the inner circle, as shown in Figure 6, and click. Set the text alignment to 
Align Center, which centers your text around the point you clicked on. 

Figure 4: The Two Circular Paths

Figure 5: The Text tool
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The Lower Text 

1. Be sure the Text tool is the active tool, then choose the settings for the lower text. I used the same text 
settings as I did for the upper text. 

2. Place the cursor on the bottom of the outer circle and click. Be sure that the text alignment is set to 
Align Center, to center your text around the point you clicked. 

3. Now we'll toggle display of the paths off, hiding the circles and showing only the text. On the Layers 
palette, expand the vector layer and click on the visibility icons for the two ellipse shapes. Figure 7 
shows the resulting Layers palette. 

4. If you want, convert the vector layer to raster. You can then add effects such as a drop shadow, as I 

Figure 6: Click on the Path to Place Your Text

Figure 7: Hiding the Paths
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did for the example shown at the beginning of this tutorial. 

Experiment with placing text on a path. You're not limited to circular paths, of course. Also try placing text on 
an S-curve or on a freehand line. Any vector path that you can define with the Draw tool or Preset Shapes tool 
will do. 

Mike Thomas is a portrait artist and an e-commerce Web site designer. He is a tutorial author for the pspPower 
newsletter. Mike has taught art in the North Carolina school system and maintains a private studio. He has also 
been a Paint Shop Pro teaching assistant at SmartPlanet and elementK, and is currently completing the 
Bachelor of Science in Information Technology requirements at the University of Phoenix. Mike has an art 
gallery and graphics site at http://www.udraw2.com.  

FilterMunky - Puzzled and More 
by Sally Beacham 

A FilterMunky "Scoop!" 

It's been a long time since we've seen something new from one of FilterMunky's very favorite plugin 
companies. But AV Bros, makers of Page Curl Pro and Puzzle Pro, have developed an updated version of 
Puzzle Pro - Puzzle Pro 2.0. And FilterMunky is proud to say he got to be the very first to monkey around with 
a pre-release version. (Puzzle Pro 2.0 is scheduled for release within 2 weeks of this writing date, so it may be 
available by the time you read this. Check www.avbros.com for further info!)  

Puzzle Pro 2.0 adds some superb functionality to the original version, including new Shaper, Mutator, and 
Layout panels within the plugin. Not only can you create marvelous puzzle effects like this: 

But you can also create maze effects, honeycomb patterns and even engraved effects… 

Figure 1: S-Eagle Puzzle
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Puzzle Pro 2.0 has so many nooks and crannies, it's absolutely astounding how much is packed in this filter. 
There are two basic panels - a Cutter panel where you can design the puzzle shape and layout the design, and 
a main panel where you can tweak the settings and choose what pieces you will show or hide. You can specify 
the numbers of rows and columns, the shape, knob size and randomness of the puzzle pattern. There are 
options to adjust the bevel settings, hue, saturation, brightness, contrast, and opacity. You can add blurs and 
color overlays and gradients. And, FilterMunky even found the Randomizer controls! 

When you are finished with all the tweaking you can do to the Cutter settings, you can export selected pieces 
to .psd format, you can save "knife" shapes to be reused, and you can save presets as well. This is one plugin 
with a lot more uses than one might initially think. It's not for the faint of heart - there's some serious power 
and flexibility inside that really cool-looking interface (and we've come to expect the very coolest interfaces 
from AV Bros!) You'll need to invest some time learning this Five Banana Filter, but it's worth it! 

FilterMunky's Banana Ratings for AV Bros Puzzle Pro 2.0  

Figure 2: Maze, Honeycomb, and Engraved effects
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Other Plugin News 

Andromeda Software (www.andromeda.com) announced some improvements to its Lens Doc plugin of interest 
to Paint Shop Pro users, specifically correction curve presets for Nikon and Olympus lenses, and a small screen 
mode (640x480) suited for laptop use. 

Those folks at Auto F/X must never sleep. Hot on the heels of Mystical Lighting, comes Mystical Tone Tint and 
Color, a collection of 38 effects to enhance and color-correct photos. The Gradient Tinting and Hand Tinting 
effects are marvelous. Check it out at www.autofx.com. 

Digital Anarchy announced the release of a new set of plugin filters for creating procedural textures and 
borders. The suite includes Texture Anarchy Explorer, Tiler Texture Anarchy (for creating seamless tiles) and 
Edge Anarchy (for borders.) The set is currently available at 
http://www.digitalanarchy.com/product_texture.html for an introductory price of $129 (regularly $149). If 
you like interesting, snazzy interfaces, and lots of configurable controls, these are your babies! 

FilterMunky’s column is written for him by Sally Beacham, Filter Frenzy instructor at www.lvsonline.com, and 
PSP Private Beta Tester. He gives her a banana, and she types fast.  
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